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Image Viewing, Organizing and Editing Software

ZoomBrowser EX
Ver. 6.1

Instruction Manual

O In this manual, ZB is used for ZoomBrowser EX.

O In this manual, the windows used in the examples are from Windows XP.

O Click on the icons below on the bottom right of the screen to switch 
between pages.

 : Go to next page    : Go to previous page

 : Return to a page you had previously displayed

O Click on the chapter headings on the right side of the screen to switch to 
the contents page of each chapter.

© CANON INC. 2008     CT1-7155ZBWE-000
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READ CAREFULLY BEFORE USING!
CANON SOFTWARE LICENSE AGREEMENT
IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM 
IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF 
THIS AGREEMENT.
This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]). 
IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT 
USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX 
(COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM 
THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.
In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions 
of this Agreement.
1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single 

computer. You may physically transfer the SOFTWARE from one computer to another provided 
that the SOFTWARE is used on only one computer at a time. You shall not install or use the 
SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware 
configuration where the SOFTWARE is accessible to more than one CPU or to more than one 
user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE, 
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE, 
ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART, 
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.
2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or 

copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer 
and retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation 
of this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support for 
use of the SOFTWARE. No updates, fixes or support will be made available for the 
SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose, 
maintain and match the hardware and software components of your computer system. Thus 
Canon does not guarantee uninterrupted service or correction of errors or that the functions or 
performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED 
ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-ROM storing the 
SOFTWARE is warranted only against defective material under normal use for a period of ninety 
(90) days after purchase from an authorized Canon dealer as evidenced by your sales receipt. 
Your sole remedy for a defective CD-ROM shall be replacement of the same without charge 
when returned by you at your expense to your point of purchase and proven to be defective 
upon inspection. The replacement CD-ROM will be warranted for the remainder of the original 
ninety (90) day warranty period of the defective CD-ROM. The limited warranty does not apply if 
the failure of the CD-ROM resulted from accident, abuse or misapplication of the SOFTWARE 
and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S 
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR 
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS 
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION, 
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF 
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE 
SOFTWARE OR THE USE THEREOF.
NEITHER CANON, NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS 
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT 
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF 
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.
5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until 

expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may 
terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate 
without notice to you if you fail to comply with any of the terms of this Agreement and you must 
then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with 
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either 
subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software clause at 
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software 
Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be 
illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void 
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this 
Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in 
the United States of America shall be governed and construed in all respects in accordance with 
the laws and regulations of the State of New York, without reference to choice of law principles. 
The terms of this Agreement as it relates to purchases of the Software in Canada shall be 
governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the 
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of 
the SOFTWARE is subject to the United States, Canada and other applicable copyright and 
trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its 
affiliated corporations and third party licensors under such laws.
Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any 
images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU 
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS 
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE 
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON 
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS 
OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS 
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO 
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY 
AUTHORIZED OFFICER OF CANON.
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Introduction

Main Features of ZB
O Download images to your computer
O Check images
O Print images
O Organize images
O Edit images

O Adjust images
O Trim images
O Insert text
O Correct red-eye

O Utilize images
O Attach an image to an e-mail
O Create wallpaper or a screen saver

O Convert images
O Change image size and type

Symbols Used
 : Selection procedure for menus that appear on the computer 

screen
[   ] : Names of items and menus, buttons, windows, etc. that appear on 

the computer screen
<  >: Camera switch name or icon, or a keyboard key name
p.** : Reference page (jump to page by clicking)

: Help : Tip

: Important information : Helpful information

Makeup of Each Chapter
Chapter 1  Basic Operation

O Starting up and exiting ZB
O Downloading images to your computer
O Checking images
O Printing images

Chapter 2  Advanced Operation
O Efficient checking of images
O Organizing images
O Editing images
O Utilizing images
O Index printing 

Chapter 3  High-Level Functions
O Checking images with high-level functions
O Organizing images with high-level functions
O Advanced image editing
O Editing RAW images
O Printing with other software

Chapter 4  Preferences
O Settings for all functions

Reference
O Solving problems
O Uninstalling ZB
O System requirements
O Supported images
O Lists of primary window functions
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Table of Contents
Chapter 1 Basic Operation.................................. 6

Starting up ZB...................................................................7

Downloading an Image to Your Computer........................7
Downloading Images Using Your Card Reader.............9

Viewing an Image ...........................................................11
View Images as Thumbnails in the Main Window .......11

Enlarging a Selected Folder .....................................12
Changing the Display Magnification .........................13

Enlarging and Viewing Images One at a Time ............13
Displaying an Image Across the Whole Window 
(Full View Display)....................................................14

Printing an Image............................................................15
Printing One Image on One Sheet of Paper ................15
Printing an Image Using Easy-PhotoPrint EX..............16

Exiting ZB .......................................................................18

Chapter 2 Advanced Operation ........................ 19
Checking/Sorting Images................................................20

Enlarging and Checking Images One at a Time..........20
Enlarging a Specific Part of an Image ......................21

Sorting Images.............................................................21
Arranging Images in the Main Window ...........................22

Extracting Images You Want to Display 
(Filter Display) ..........................................................22

Efficiently Checking/Sorting Images ...............................23

Organizing Images ......................................................... 24
Creating a Folder for Saving Images........................... 24
Moving Images ............................................................ 25

Moving Images in Folders ........................................ 25
Changing Image File Names or Folder Names ........... 26
Deleting Images........................................................... 26

Deleting Folders ....................................................... 27
Registering Frequently-Used Folders as Favorite 
Folders......................................................................... 27

Deleting Favorite Folders ......................................... 28
Editing an Image............................................................. 29

Automatic Adjustment Using ZB.................................. 29
Adjusting Brightness, Color and Contrast.................... 31
Trimming an Image...................................................... 32
Inserting Text into Images ........................................... 33
Adjusting Sharpness.................................................... 34
Correcting Red-Eye Automatically............................... 35

Correcting Red-Eye Manually .................................. 35
Utilizing Your Images...................................................... 36

Viewing Images as a Slide Show ................................ 36
Sending an Image by E-Mail ....................................... 37
Creating Wallpaper from an Image.............................. 38
Creating a Screen Saver from an Image..................... 39

Writing Images to a CD .................................................. 41

Printing Multiple Images on One Sheet of Paper 
(Index Printing) ............................................................... 42



4

1
2
3
4

Introduction

Table of 
Contents

Basic 
Operation

Advanced 
Operation

High-Level 
Functions

Reference

Preferences

Contents 
Lookup

Index

Chapter 3 High-Level Functions....................... 43
Comparing Multiple Images ............................................44

Listing Images by Folder Level .......................................45
Changing the Levels of the Displayed Folders ............46

Viewing Shooting Information for an Image....................47

Changing the Size and Type of an Image and Saving ...48

Exporting Shooting Information ......................................49

Organizing Images Using High-Level Functions.............50
Setting Keywords in Images ........................................50
Entering Comments into Images .................................50
Saving Multiple Images with New File Names.............51
Classifying Images by Shot Date.................................52

Searching for Images......................................................53

Performing Advanced Editing .........................................54
Adjusting the Color of an Image in RGB .....................54
Adjusting the Brightness Level ...................................55
Adjusting the Tone Curve ............................................55
Unsharpening an Image ..............................................56
Transferring Images to Other Image Editing 
Software.......................................................................57
Merging Images to Create Panorama Images.............57

Adjusting RAW Images................................................... 59
Applying Picture Style Files ......................................... 61
White Balance Files and Tone Curve Files ................. 62

Saving White Balance Files...................................... 62
Saving Tone Curve Files (Excludes the EOS-1Ds 
Mark III and EOS-1D Mark III).................................. 63

Adding Sound to Images/Playing Back .......................... 63
Adding Sound to Images ............................................. 63
Playing Back Sound .................................................... 63

Printing Using Other Printing Software........................... 64

Chapter 4 Preferences....................................... 65
Preferences .................................................................... 66

General Settings.......................................................... 66
Selection Settings........................................................ 67
Rotation Settings ......................................................... 67
Printing Settings .......................................................... 68
Shooting Information Settings ..................................... 68
Themes Settings.......................................................... 69

Showing/Hiding Task Buttons......................................... 69
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Troubleshooting ..............................................................71

Deleting the Software (Uninstalling) ...............................71
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List of Main Window Functions .......................................73
Zoom Mode..................................................................73
Scroll Mode..................................................................74
Preview Mode..............................................................75
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List of Photo Print Window Functions .............................77

List of Index Print Window Functions..............................78

List of RAW Image Task Main Window Functions..........79
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Index ...............................................................................81
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Basic Operation
Starting up ZB............................................................  7
Downloading an Image to Your Computer ................  7

Downloading Images Using Your Card Reader............  9
Viewing an Image ....................................................  11

View Images as Thumbnails in the Main Window ...... 11
Enlarging a Selected Folder ................................... 12
Changing the Display Magnification ....................... 13

Enlarging and Viewing Images One at a Time ........... 13
Displaying an Image Across the Whole Window (Full 
View Display).......................................................... 14

Printing an Image ....................................................  15
Printing One Image on One Sheet of Paper............... 15
Printing an Image Using Easy-PhotoPrint EX ............ 16

Exiting ZB ................................................................  18
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Starting up ZB
Double-click the desktop icon.

¿ZB starts up and the main window appears.

Double-click

Main window

The [CANON iMAGE GATEWAY] button may not be displayed 
depending on the area you are in.

Downloading an Image to Your Computer
Connect the camera and computer with the cable provided and 
download the images saved on the memory card inside the camera.
For downloading images, start up the camera software “EOS Utility” 
from ZB and use.

1 Select the save destination for the images.

O When creating a folder, refer to p.24.

Click to display the [All 
Folders] tab sheet

Click
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2 Start up EOS Utility.
O Click the buttons [Acquire & Camera Settings]  [Connect to 

EOS Camera].

¿EOS Utility starts up.

EOS Utility

3 Connect your camera and computer and turn the 
camera on.
O Connect the camera and your computer with the interface cable 

provided with the camera and turn the camera on.
O For detailed instructions on connecting your camera and 

computer, refer to the “EOS Utility Instruction Manual” (PDF 
electronic manual).

O When the dialog box below appears, select [Canon EOS Utility] 
and then click the [OK] button.
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4 Download images.

¿Downloading of images begins.
¿The downloaded images are saved in the folder selected in step 

1 and are displayed in the main window of ZB.
¿The downloaded images are sorted into folders by date and 

saved.
O Click the EOS Utility [Quit] button to exit EOS Utility and turn the 

camera’s power switch to < OFF >.

Click

Using EOS Utility to download images makes it easier to organize your 
images as they are downloaded, sorted and saved into folders by date.

Advantages of using EOS Utility to download images

You can also download images to the computer using a third-party card 
reader.

1 Select the save destination for the images (p.7).

2 Load the memory card into the card reader.

O When the dialog box below appears, select [using Canon 
ZoomBrowser EX] and then click the [OK] button. ZB starts up.

¿Proceed to step 4.

Downloading Images Using Your Card Reader
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3 Start up ZB.
O Click the buttons [Acquire & Camera Settings]  [Acquire 

Images from Memory Card].

¿Download images window appears.

4 Download images.

¿Downloading of images begins.
¿The downloaded images are saved in the folder selected in step 

1 and are displayed in the main window of ZB.
¿The downloaded images are sorted into folders by date and 

saved.
O Click the [Exit] button to exit Download images window.

Click

Download images window

Using ZB to download images makes it easier to organize your images 
as they are downloaded, sorted and saved into folders by date.

Advantages of using ZB to download images
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Viewing an Image
Images downloaded to your computer are displayed as a thumbnails list 
in the main window. You can double-click an image to open the viewer 
window and display the image at a larger size.

O To select multiple images, click on the images while holding 
down the < Ctrl > key on the keyboard.

View Images as Thumbnails in the Main Window

Main window
Click to select the image

Display thumbnails of all the 
images inside the folder selected 
in the folder area on the left

Move the cursor over the image with the 
mouse and you can check images that 
are displayed in the simple display 
window (mouse over window).
To deactivate simple display, click on 
[ ] on the top of the window, select 
[Show Mouse Over Windows] from the 
menu and remove the check mark.

Simple Display Function

For a list of the main window functions, refer to p.73.

Simple display window
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Enlarging a Selected Folder
Images downloaded to your computer are displayed in folders in the 
main window. Double-click on an empty part of the folder you want to 
enlarge to zoom in and display the images inside that folder at a larger 
size.

Enlarge folders.

¿The folder you have double-clicked zooms in.

Double-
click on an 
empty part 
of the folder

O To revert to the folder size before enlarging, click [ ] on the top 
of the window.

You can change the speed at which a folder zooms in (p.66).
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Changing the Display Magnification
If you have many images inside a folder and they are small and difficult 
to see, you can change the display magnification and display the 
images at a larger size.

Change the display magnification.

O You can also change the display magnification by clicking [ ] 
or [ ].

¿The display magnification of the images changes.

O The [Navigator] window appears and you can check and move 
the enlargement display position.

O You can also move the enlargement display position by clicking 
[ ] on the top of the window and dragging over the window.

O To return to full view, click [ ] on the top of the window.

Drag to the right

Navigator window

Enlargement 
display position
Drag to move the 
enlargement 
display position

1 Double-click an image to enlarge.

¿The viewer window appears.

Enlarging and Viewing Images One at a Time

Double-click



14

1
2
3
4

Introduction

Table of 
Contents

Basic 
Operation

Advanced 
Operation

High-Level 
Functions

Reference

Preferences

Contents 
Lookup

Index

2 Click [ ] or [ ] to switch to the image you want to 
display.

O The shooting information is displayed by clicking [ ] on the 
top of the window.

O To exit the viewer window, click [ ] on the top right of the 
window.

Viewer window

The [Display Original Image] button appears at the bottom of the 
window. Click this button to display the processed image.

When you display RAW images in the viewer window

For a list of viewer window functions, refer to p.76.

Displaying an Image Across the Whole Window (Full View Display)
Double-click on the image you want to display 
across the whole window.

O You can also display the image across the whole window by 
clicking [ ] on the top of the window.

¿The image is enlarged and displayed across the whole window.

O To return to the viewer window, click on the window or press the 
< Esc > key on the keyboard.

Double-click
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Printing an Image
This section explains how to print one image on one sheet of paper, and 
how to print using Easy-PhotoPrint EX.

You can print one image on one sheet of paper.

1 Select the image to be printed.

O To select multiple images, click on the images while holding 
down the < Ctrl > key on the keyboard.

O You can select all the images inside a folder by clicking on an 
empty part of the folder.

Printing One Image on One Sheet of Paper

Click

2 Display the print settings window.
O Click the buttons [Print & Email]  [Photo Print].

¿The [Photo Print] window appears.

3 Set the paper size and other settings, and then click 
the [Print] button.

¿Printing begins.

Photo Print window

For a list of photo print window functions, refer to p.77.
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If you have an inkjet printer that is compatible with the Easy-PhotoPrint 
EX (hereinafter, “EPP EX”) software for Canon printers, you can start up 
EPP EX from within ZB and easily perform high-quality photo printing. 
To perform this printing, it is necessary to first install EPP EX version 1.0 
or later on your computer.
Also, Easy-PhotoPrint users can select [Easy-PhotoPrint] in step 2 and 
print following the same steps.

1 Select the image to be printed.

O To select multiple images, click on the images while holding 
down the < Ctrl > key on the keyboard.

O You can select all the images inside a folder by clicking on an 
empty part of the folder.

Printing an Image Using Easy-PhotoPrint EX

Click

2 Start up EPP EX.
O Click the buttons [Print & Email]  [Easy-PhotoPrint EX Photo 

Print].

¿EPP EX starts up.

3 Specify the number of copies to be printed and then 
click [Select Paper].
Easy-PhotoPrint EX

Click to increase the number of copies to be printed
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4 Specify the paper size and then click [Layout/Print]. 5 Specify the layout and then click the [Print] button.

¿Printing begins.

You can also create an album with EPP EX by clicking the [Create 
and Print Album] button in the menu in step 2.
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Exiting ZB
In the main window, select the [File] menu  [Exit].

¿ZB exits.
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Advanced Operation
Checking/Sorting Images ......................................... 20

Enlarging and Checking Images One at a Time........  20
Enlarging a Specific Part of an Image ...................  21

Sorting Images...........................................................  21
Arranging Images in the Main Window .................... 22

Extracting Images You Want to Display (Filter 
Display) ...............................................................  22

Efficiently Checking/Sorting Images......................... 23
Organizing Images ................................................... 24

Creating a Folder for Saving Images.........................  24
Moving Images ..........................................................  25

Moving Images in Folders......................................  25
Changing Image File Names or Folder Names........  26
Deleting Images.........................................................  26

Deleting Folders.....................................................  27
Registering Frequently-Used Folders as Favorite 
Folders ....................................................................  27

Deleting Favorite Folders.......................................  28
Editing an Image ...................................................... 29

Automatic Adjustment Using ZB................................  29
Adjusting Brightness, Color and Contrast..................  31
Trimming an Image....................................................  32
Inserting Text into Images .........................................  33
Adjusting Sharpness..................................................  34
Correcting Red-Eye Automatically.............................  35

Correcting Red-Eye Manually................................  35

Utilizing Your Images...............................................  36
Viewing Images as a Slide Show ............................... 36
Sending an Image by E-Mail ...................................... 37
Creating Wallpaper from an Image............................. 38
Creating a Screen Saver from an Image.................... 39

Writing Images to a CD ...........................................  41
Printing Multiple Images on One Sheet of Paper 
(Index Printing) ...................................................... 42
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Checking/Sorting Images
You can enlarge images one at a time from a list in the main window and 
check what they look like in detail, and sort them into one of three 
groups with [ ] (ratings).

1 Double-click on the image on the top left of the main 
window.

¿The viewer window appears.

Enlarging and Checking Images One at a Time

Double-click

2 Click [ ] or [ ] to switch to the image you want to 
display.

O The shooting information is displayed by clicking [ ] on the 
top of the window.

O To exit the viewer window, click [ ] on the top right of the 
window.

Viewer window

Select multiple images in the main window (p.11) and then click on 
[ ] on the top left of the main window (p.73) to display only 
the selected images in the viewer window.

To display only selected images in the viewer window

For a list of viewer window functions, refer to p.76.
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Enlarging a Specific Part of an Image

1 Enlarge an image.

O You can also change the display magnification by clicking [ ] 
or [ ].

¿The image enlarges and the [Navigator] window appears.

2 Display the part of the image you want to check.
O Drag the enlargement display position in the [Navigator] window 

and display the part of the image you want to check.

O You can also move the enlargement display position by clicking 
[ ] on the top left of the window and dragging over the window.

O To return to full view, click [ ] on the top left of the window.

Drag to the right

Navigator window

Enlargement 
display position
Drag to move the 
enlargement 
display position

Enlargement ratio

RAW images cannot be enlarged before they are processed. By clicking 
the [Display Original Image] button on the bottom of the window, the 
image is processed and it can be enlarged.

Enlarging RAW images

You can sort images into one of three groups by attaching [ ] (ratings) 
according to photo subject or theme. Please note that [ ] is 
automatically attached to images shot with your camera.

Increase or decrease a rating.

Sorting Images

Click to increase
Click to decrease
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Arranging Images in the Main Window
You can arrange images in order of how many [ ] you have attached 
to it (ratings), or according to the image’s shooting date and time.

Select the [View] menu  [Sort by]  desired item.

¿The images are arranged in the order according to the selected 
item.

Sort item Description
Star Rating Images are arranged in the order of the least number of [ ].
Name Image file names are arranged in the order of 0 – 9  a – z.
Shooting Date Images are arranged in the order of most recently shot.
Modification Date Images are arranged in the order of most recently updated.
Type Images are arranged in the order of BMP images  

RAW images  JPEG images  TIFF images.

Ascending Images are arranged from top to bottom in order of sorting criteria.
Descending Images are arranged from bottom to top in order of sorting criteria.

Extracting Images You Want to Display (Filter 
Display)
You can extract images displayed in the main window by the number of 
[ ] you have attached to them (ratings).

1 Click the [ ] button.

¿The extract function appears.

2 Checkmark the number of [ ] you want to extract 
and display.

¿Only the images with the number of [ ] you have checkmarked 
are displayed in the main window.

O To exit the extract display, click the [ ] button again.
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Efficiently Checking/Sorting Images
With Preview Mode that displays images as thumbnails and as single 
images in the same window, you can sort images by the number of 
[ ] while checking efficiently. You can also simultaneously check 
shooting information for images.

1 Enable Preview Mode.

¿The main window display switches to Preview Mode.
Click

2 Click the [ ] or the [ ] button 
to switch to the image you want to check, and then 
sort with the number of [ ].

O You can also click on the image in the thumbnail image display 
area to display the image enlarged in the center of the window.

The selected image is enlarged in the center of the window

Thumbnail image display area

Click to increase or decrease

You can double-click the folder icon to display the images in the folder in 
the thumbnail image display area.

When a folder icon appears in the thumbnail image display area

For a list of Preview Mode functions, refer to p.75.
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Organizing Images
This section explains functions that are useful for organizing images 
such as creating new folders for saving sorted images, moving and 
copying images and deleting unwanted images.

You can create a folder to save sorted images.

1 In the folder area, select the location where the new 
folder is to be created.

Creating a Folder for Saving Images

2 Select the [File] menu  [New Folder].

¿The [New Folder] dialog box appears.

3 Enter a folder name and click the [OK] button.
¿The new folder is created in the folder selected in step 1.
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You can move or copy images to separate folders and organize them 
according to shot date or theme.

Drag the image to be moved or copied.
O To move:Drag the image and release when the image is in the 

destination folder.
O To copy: Drag the image while holding down the < Ctrl > key and 

release when the image is in the destination folder.

¿The image is moved or copied to the folder it was dragged to.

Moving Images

Drag an image in the main window to a folder in the folder area on the 
bottom left of the window in the same way as described above to move 
or copy the image.

Moving images to a folder in the folder area

Moving Images in Folders
You can move or copy folders that contain images, and organize images 
in folders.

Drag the folder to be moved or copied.
O To move:Drag the folder and release when the folder is in the 

destination folder.
O To copy: Drag the folder while holding down the < Ctrl > key and 

release when the folder is in the destination folder.

¿The folder is moved or copied to the folder it was dragged to.

Drag a folder in the main window to a folder in the folder area on the 
bottom left of the window in the same way as described above to move 
or copy a folder.

Moving folders in the folder area
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1 Select the image whose name you want to change in 
the main window, or select the folder whose name 
you want to change in the folder area.

2 Select the [File] menu  [Rename].

¿The [Rename Image] or [Rename Folder] dialog box appears.

3 Enter the file name or folder name of the image and 
then click the [OK] button.
¿The file name or folder name changes to the new name.

Changing Image File Names or Folder Names

O You can also change the file names in the [Properties] window 
(p.47) or the image display area in Preview Mode (p.75).

O You can also change the folder names in the [Properties] window 
(p.47).

Please take care as deleted images cannot be recovered.

1 Select the unwanted image in the main window.

2 Click [Delete].

¿The [Confirm File Delete] dialog box appears.

3 Click the [Yes] button.
¿The image is moved to the [Recycle Bin] and is deleted from ZB.
O Right-click [Recycle Bin] on the desktop and select [Empty 

Recycle Bin] from the menu that appears to delete the image 
from your computer.

Deleting Images

Click
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Deleting Folders
Deleted folders cannot be recovered. Please take care as all images 
inside folders are also deleted.

1 In the folder area, select the folder you want to 
delete.

2 Select the [File] menu  [Delete].

¿The [Confirm File Delete] window appears.

3 Click the [Yes] button.
¿The folder is moved to the [Recycle Bin] and is deleted from ZB.
O Right-click [Recycle Bin] on the desktop and select [Empty 

Recycle Bin] from the menu that appears to delete the folder 
from your computer.

You can register shortcuts for frequently-used folders in the [Favorite 
Folders] tab sheet in the folder area to make images easier to find.
Please note that because the [My Pictures] folder is registered as a 
favorite folder by default, the folder icon appears as [ ].

1 Select the folder you want to register.

2 Click the [Add to Favorites] button.
¿The folder icon changes to [ ] and is registered as a favorite 

folder.

Registering Frequently-Used Folders as Favorite Folders



28

1
2
3
4

Introduction

Table of 
Contents

Basic 
Operation

Advanced 
Operation

High-Level 
Functions

Reference

Preferences

Contents 
Lookup

Index

3 Select the [Favorite Folders] tab sheet.

4 Select the registered folder to display the images 
inside the folder.

¿The images inside the folder appear.

Click

Any changes done to images inside registered folders will be applied to 
the original images. Therefore, please be aware that by editing or 
deleting images inside registered folders, you are in fact editing or 
deleting the original images.

If you have edited or deleted images in folders you have 
registered as favorites

Deleting Favorite Folders
If you no longer need a folder you have registered in the [Favorite 
Folders] tab sheet, you can delete it from this tab sheet.
Please note that as registered folders are shortcuts, the original folder 
will not be deleted when you delete the shortcut.

In the [Favorite Folders] tab sheet, select the folder 
you want to delete and then click the [Remove] 
button.

¿The folder is deleted.
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Editing an Image
If the brightness or color of images is different from what you visualized 
when you shot the photo, you can adjust an image using the editing 
functions to bring them closer to what you visualized.
This section explains about automatic adjustment of images, adjustment 
of brightness, saturation and contrast, trimming images, inserting text 
into images, adjustment of sharpness and red-eye correction.
JPEG images deteriorate slightly when edited and saved, and the image 
before editing cannot be recovered. For this reason, an edited JPEG 
image should be saved as a separate image from the original image.
Chapter 3 explains about high-level editing functions other than those 
described above and adjustment of RAW images.

The brightness and colors, etc. of the image are automatically adjusted.

1 Select the image you want to edit.

2 Click the buttons [Edit]  [Edit Image].

¿The [Edit Image] window appears.

Automatic Adjustment Using ZB

3 Select the buttons [Auto Adjustment]  [Finish].

¿The [Auto Adjustment] window appears.

Edit Image window
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4 Click the [Auto Adjust Image] button.

¿The image is adjusted.

5 Enlarge the window and check the adjustments.

O In enlarged view, the [Navigator] window appears and you can 
check and move the enlargement display position.

Auto Adjustment window

Drag right to enlarge
Fits the image to the window size

Moves the enlargement display position
Zooms in/Zooms out

O To revert to full view, click [ ] on the bottom left of the window.

6 Click the [Save As] button and save as a separate 
image.

¿The [Save As] window appears.

7 Specify the save destination and then click the 
[Save] button.
¿The edited image is saved as a separate image from the original 

image.

Window in enlarged display

Enlargement display position
Drag to move the enlargement display position
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You can adjust the brightness, color (saturation) and contrast of images.

1 Select the image you want to edit and display the 
[Edit Image] window (p.29).

2 Select [Color/Brightness Adjustment] and then click 
the [Finish] button.
¿The [Color/Brightness Adjustment] window appears.

3 Adjust the image.

O Move the slider to the right to make the [Brightness] of an image 
appear brighter, the [Saturation] to appear more vivid and the 
[Contrast] stronger. Move the slider to the left to make the image 
appear darker, and the saturation and the contrast weaker.

¿The image is adjusted.

Adjusting Brightness, Color and Contrast

Drag to the left or right to adjust
Color/Brightness Adjustment window

4 Enlarge the window and check the adjustments (p.30).

5 Click the [Save As] button and save as a separate 
image (p.30).
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You can trim only the part of an image you need, or change the 
composition of an image where an image shot horizontally becomes 
vertical.

1 Select the image you want to edit and display the 
[Edit Image] window (p.29).

2 Select [Trim] and then click the [Finish] button.
¿The [Trim Image] window appears.

3 Drag the trimming range.

O The trimming range can be moved by dragging.
O You can change the trimming range by dragging the four corners 

and the four sides of the trimming range.

Trimming an Image

Trim Image window

Drag

4 Click the [Trim Image] button.

¿The image is trimmed.

5 Click the [Save As] button and save as a separate 
image (p.30).
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You can insert the date and time you shot an image and text into an 
image as text.

1 Select the image you want to edit and display the 
[Edit Image] window (p.29).

2 Select [Insert Text] and then click the [Finish] button.
¿The [Insert Text] window appears.

3 Drag the range for inserting text.

O The text insertion range can be moved by dragging.
O You can change the text insertion range by dragging the four 

corners and the four sides of the text insertion range.

Inserting Text into Images

Insert Text window

Drag

4 Using the keyboard, enter the text you want to insert.

¿The text you enter appears in the window.

5 Click the [Save As] button and save as a separate 
image (p.30).
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You can make the overall atmosphere of an image harder or softer.

1 Select the image you want to edit and display the 
[Edit Image] window (p.29).

2 Select [Sharpness] and then click the [Finish] button.
¿The [Sharpness] window appears.

3 Adjust the image.

O Move the slider to the right to make an image harder and to the 
left to make an image softer.

¿The image is adjusted.

Adjusting Sharpness

Sharpness window
Drag right to adjust

4 Enlarge the window and check the adjustments (p.30).

5 Click the [Save As] button and save as a separate 
image (p.30).
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You can automatically detect and correct red-eye that occurs when you 
photograph people using a flash.

1 Select the image you want to edit and display the 
[Edit Image] window (p.29).

2 Select [Red Eye Correction] and then click the 
[Finish] button.
¿The [Red Eye Correction] window appears.

3 Click the [Start] button.

¿The image is corrected.

4 Click the [Save As] button and save as a separate 
image (p.30).

Correcting Red-Eye Automatically

Red Eye Correction window

Correcting Red-Eye Manually
You can manually correct red-eye that cannot be corrected automatically.

1 Display the [Red Eye Correction] window (Description 
on the left).

2 Enlarge the image (p.30).

3 Select [Manual Mode] and then click [ ].

4 Click on the places in the image you want to correct.
¿When you move the mouse cursor on the places to be corrected, 

[ ] is displayed.

¿The image is corrected.

5 Click the [Save As] button and save as a separate 
image (p.30).

Click
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Utilizing Your Images
You can view your images as a slide show, send them in an e-mail or 
use them as wallpaper or screen savers for your computer.

You can display selected images across the whole window and switch 
between them as a slide show.

1 Select images.

2 Click [Slide Show].

¿The [View as a Slide Show] window appears.

Viewing Images as a Slide Show

3 Set the slide show style and then click the [Finish] 
button.

¿The Slide Show window appears and the slide show begins.

View as a Slide Show window
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Index*1 The image is selected. When the slide show ends and returns to 
the main window, the image is displayed as being selected.

*2 The image is selected for printing. When the slide show ends and 
returns to the main window, the print dialog box is displayed.

¿When all the images have been displayed, the Slide Show 
window closes and returns to the main window.

O To end the slide show half-way through, click [ ].

Slide Show window

File name Rating setting
Selects the image*1

Prints the image*2

Switches to the previous image
Pauses the slide show
Switches to the next image
Ends the slide show

You can attach a selected image to an e-mail and send it.
The attached image to be sent is a copy of the original image and 
therefore the original image remains unaffected on your computer.
Please note that the e-mail software for attaching and sending an image 
selected in ZB is MAPI-compatible software. Please consult the 
Instruction Manual for your e-mail software for settings related to MAPI.

1 Select an image.

2 Click the buttons [Print & Email]  [Email Images].

¿The [Email Images] window appears.

Sending an Image by E-Mail
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3 Select [Using the recommended settings.], and then 
click the [Attach to Email] button.

¿The e-mail software starts up and the image is attached to an e-
mail.

O Enter the address and a message and send the e-mail.

Email Images window You can make a selected image wallpaper for your computer.
The bitmap image for the wallpaper (extension “.BMP”) is created using 
a copy of an image and therefore the original image remains unaffected.

1 Select an image.

2 Click the buttons [Export]  [Export as a Wallpaper].

¿The [Export as a Wallpaper] window appears.

Creating Wallpaper from an Image
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3 Specify the layout and the save destination for the 
wallpaper, and then click the [Finish] button.

¿The image you selected for your wallpaper is applied as 
wallpaper.

¿The image you selected for your wallpaper is saved in the 
specified folder.

Export as a Wallpaper window

1 On the desktop, right-click with the mouse and in the menu that 
appears, select [Properties].

2 Select the [Desktop] tab sheet.
3 Select the file to become the wallpaper and then click the [OK] button.

To revert to the original wallpaper

You can make a selected image a screen saver for your computer.
The data for the screen saver (extension “.SCR”) is created using a 
copy of an image and therefore the original image remains unaffected.

1 Select an image.

2 Click the buttons [Export]  [Export as a Screen 
Saver].

¿The [Export as a Screen Saver] window appears.

Creating a Screen Saver from an Image
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3 Checkmark [Include images in the screen saver] and 
click the [Finish] button.

¿The data for the screen saver is saved in the specified folder.

Export as a Screen Saver window

4 Specify the saved screen saver on your computer.
O On the desktop, right-click with the mouse and in the menu that 

appears, select [Properties]. Display the [Screen Saver] tab 
sheet in the [Display Properties] dialog box.

Applies the selected screen saver data
Select the saved screen saver data

When you checkmark [Include images in the screen saver] in step 3, the 
original image is copied to create the data for the screen saver. This 
means that even if the original image is deleted or the file name is 
changed, it does not affect the screen saver. However, if you remove the 
check mark, the data is created using the original image, and if the 
original image is deleted or the file name is changed, the screen saver 
will not work properly.

About the [Include images in the screen saver] checkbox
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Writing Images to a CD
You can write selected images to a CD.
This function is only compatible with a computer that has Windows Vista 
or Windows XP preinstalled and is equipped with a standard CD-R/RW 
drive.

1 Insert a CD-R/RW disk in the CD-R/RW drive.
O When the dialog box below appears, select the [Cancel] to close 

the dialog box.

2 Select the images you want to write to the CD.

3 Click the buttons [Export]  [Backup to CD].

¿The [Backup to CD] window appears.

4 Specify the settings for writing to the CD-R/RW disk 
and then click the [Finish] button.

¿Writing to the CD-R/RW begins.

Backup to CD window
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Printing Multiple Images on One Sheet of Paper (Index Printing)
You can arrange multiple images in index format and print them on one 
sheet of paper.

1 Select the images.

2 Click the buttons [Print & Email]  [Index Print].

¿The [Index Print] window appears.

3 Specify settings such as the paper type and the 
number of prints, and then click the [Print] button.

¿Printing begins.

Print preview
Index Print window

For a list of index print window functions, refer to p.78.
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Comparing Multiple Images
To compare multiple images, you can split the viewer window into two, 
three or four and display multiple images at the same time.
You can also align the display position of enlarged images and compare.

1 In the main window, select the images you want to 
compare (p.11).

2 Click [ ] (p.73).
¿The viewer window appears.

3 Select the number of images you want to display at 
the same time.

¿The viewer window is split and the multiple images are displayed 
at the same time.

Example of display when [ ] is clicked

4 Click [Synchronize] and then enlarge the image.

¿The synchronize display appears and all the images are 
displayed at the same display magnification and in the same 
position.

¿The [Navigator] window that displays the enlargement display 
position appears and you can check and move the enlargement 
display position (p.21).

O Click [Synchronize] again to cancel the synchronize display. You 
can now change the display magnification and move the 
enlargement display position for each image.

O To return to full view, click [ ] on the top left of each window.
O To cancel the split display, click [ ] at the top of the window.

Drag right to change the display magnification

Click
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Listing Images by Folder Level
You can switch the main window display to Scroll Mode that displays in 
folder levels and simultaneously view multiple folders and images inside 
the folders.

1 Click the [Scroll Mode] tab sheet.

¿The display in the main window switches to Scroll Mode.

2 Check the images inside the folders.

¿The images inside the folder are displayed.

Click Number of images inside the folder 
and number of folders

For a list of Scroll Mode window functions, refer to p.74.
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You can set the level to which images and folders are displayed in the 
window, which makes looking for the folders and images you want 
easier.

1 Select the [Tools] menu  [Preferences].
¿The [Preferences] window appears.

2 Change the depth of the folder level to be displayed.

Changing the Levels of the Displayed Folders 3 Click the [OK] button.
¿The main window is displayed at the folder depth you set.

¿Folders up to the third level and images inside the folders are 
displayed in the window.

O Folders at or higher than the fourth level are displayed as folder 
icons. Double-click these folders to display images and folders 
inside the folders.

Example of display when you have set the folder level setting [3]
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Viewing Shooting Information for an Image
1 Enable Zoom Mode (p.73) or Scroll Mode (p.74).

2 Select the image for which you want to view the 
information.

3 Click [Properties].

¿The [Properties] window (image information window) appears.

Properties window

In Preview Mode, the same information as the [Properties] window 
is displayed on the information display area (p.75).
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Changing the Size and Type of an Image and Saving
You can change the size of an image or convert it to a TIFF image 
(extension “.TIFF”) or a bitmap image (extension “.BMP”) and save it. 
Because the image is saved as a separate image, the original image 
remains unaffected.

1 Select an image.

2 Click the buttons [Export]  [Export Still Images].

¿The [Export Still Images] window appears.

3 Specify the image size, type, file name and save 
destination, and then click the [Finish] button.

¿The image is saved as an image separate from the original 
image.
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Exporting Shooting Information
You can export as a text file the shooting information recorded to the 
image.

1 Select an image.

2 Click the buttons [Export]  [Export Shooting 
Properties].

¿The [Export Shooting Properties] window appears.

3 Specify the export shooting information and save 
destination, and then click the [Finish] button.

¿The shooting information is saved as a text file (extension 
“.TXT”).
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Organizing Images Using High-Level Functions
You can organize images using high-level functions such as setting 
keywords and entering comments, renaming multiple files in a single 
operation and classifying images by shot year/month/date, all of which 
are useful when organizing your images.

You can set keywords to identify images. The set keywords are also 
useful when searching for images (p.53).

1 Display the [Properties] window (p.47).

2 Click the [ ] button in [Keywords] and then click 
the [View/Modify Keywords].
¿The [View/Modify Keywords] dialog box appears.

3 Select the keyword(s) and then click the [OK] button.

¿The keyword is set in the image.

Setting Keywords in Images

You can enter information relating to images as comments. The entered 
comments are also useful when searching for images (p.53).

1 Display the [Properties] window (p.47).

2 Click the [ ] button in [Comment].
¿A field for entering comments is displayed.

3 Enter text and then press the < Enter > key on the 
keyboard.

¿The entered text is saved in the image.

Entering Comments into Images
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You can copy multiple images and save them with new file names in a 
single operation.

1 Select all the images you want to save with new file 
names (p.11).

2 Click the buttons [View & Classify]  [Rename 
Multiple Files].

¿The [Rename Multiple Files] window appears.

Saving Multiple Images with New File Names 3 Checkmark [Make copies of files], enter the file name 
and then click the [Finish] button.

¿ Images separate from the original images are saved with the new 
names.

In step 3, if you remove the check mark from [Make copies of files] 
in the window, please be aware that the file name for all the selected 
images including the original images changes.
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Multiple images can be classified into different folders according to shot 
date.

1 Select all the images to be classified (p.11).

2 Click the buttons [View & Classify]  [Classify into 
Folder].

¿The [Classify into Folder] window appears.

Classifying Images by Shot Date

Settings for Folder Structure

3 Specify the folder structure and save destination, 
and then click the [Finish] button.

¿ Images are classified by shot date.

Setting Item Description
YearMonthDate Classifies images by creating a first-level folder 

according to shot year/month/date.
Year\YearMonthDate Classifies images by creating a second-level folder 

for the shot year, and the month and date.
Year\Month\
YearMonthDate

Classifies images by creating a third-level folder 
for the shot year, the month, and the date.
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Searching for Images
You can search for images by ratings (p.21), shot date, update, 
comments (p.50) and keywords (p.50).

1 Click the buttons [View & Classify]  [Search].

¿The [Search] window appears.

2 Specify the search criteria and then click the [Next] 
button.

¿The search begins and the images that match the criteria are displayed.

3 Click the [Finish] button to close the search results 
window.
¿The display returns to the main window.

4 Check the searched images in the main window.
O The searched images are displayed as [Search Results] in the 

folder area in the main window. If you select this folder, the 
searched images are displayed.

O The images inside the [Search Results] folder are stored until 
you either perform another search or exit ZB.

O Any work you do on images inside the [Search Results] folder will 
be applied to all the original images. Therefore, please be aware 
that if you edit or delete images inside the [Search Results] 
folders, the original images will be edited or deleted also.

You can click the [ ] button in the main window and display 
the [Search] window.
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Performing Advanced Editing
This section explains image editing using high-level functions based on 
the assumption that you are familiar with handling standard image 
editing software. 
JPEG images deteriorate slightly when edited and saved, and the image 
before editing cannot be recovered. For this reason, an edited JPEG 
image should be saved as a separate image from the original image.

You can adjust the color of an image in RGB (red, green, blue).

1 Select an image and display the [Edit Image] window 
(p.29).

2 Select [Color/Brightness Adjustment] and then click 
the [Finish] button.
¿The [Color/Brightness Adjustment] window appears.

3 From the list box, select [RGB Adjustment].

¿The window switches to the [RGB Adjustment] window.

Adjusting the Color of an Image in RGB 

4 Adjust the image.

¿The image is adjusted.

5 Click the [Save As] button and save as a separate 
image (p.30).

Drag to the left or right to adjust
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You can adjust the level of brightness (balance).

1 Select an image and display the [Edit Image] window 
(p.29).

2 Select [Color/Brightness Adjustment] and then click 
the [Finish] button.
¿The [Color/Brightness Adjustment] window appears.

3 From the list box (p.54), select [Level Adjustment].
¿The window switches to the [Level Adjustment] window.

4 Adjust the image.

¿The image is adjusted.

5 Click the [Save As] button and save as a separate 
image (p.30).

Adjusting the Brightness Level 

Drag to the left or right to adjust

You can adjust the brightness, contrast and color of a specific area by 
changing the tone curve.

1 Select an image and display the [Edit Image] window 
(p.29).

2 Select [Color/Brightness Adjustment] and then click 
the [Finish] button.
¿The [Color/Brightness Adjustment] window appears.

3 From the list box (p.54), select [Tone Curve 
Adjustment].
¿The window switches to the [Tone Curve Adjustment] window.

Adjusting the Tone Curve
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4 Adjust the image.

¿The image is adjusted.
O The horizontal axis shows the input level and the vertical axis 

shows the output level.
O The maximum number of [ ] is 10.
O To delete a [ ], either press the < Del > key on the keyboard or 

double-click on the [ ].

5 Click the [Save As] button and save as a separate 
image (p.30).

Click to add a [ ] (point)
Adjust by dragging [ ]

You can set amount, radius and threshold values and adjust sharpness.

1 Select an image and display the [Edit Image] window 
(p.29).

2 Select [Sharpness] and then click the [Finish] button.
¿The [Sharpness] window appears.

3 Select the [Unsharp Mask] tab sheet and adjust.

¿The image is adjusted.

4 Enlarge the window and check the adjustments (p.30).

5 Click the [Save As] button and save as a separate 
image (p.30).

Unsharpening an Image

Drag right to adjust
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You can transfer images to image editing software other than ZB.

1 Select an image and display the [Edit Image] window 
(p.29).

2 Select [Edit with external image editor].

3 Click the [Manage List] button and then register the 
image editing software.
O Select the image editing software in the window that appears.

4 In the [Edit with external image editor] list box, select 
the registered image editing software.

5 Click the [Finish] button.
¿The software selected in step 4 starts up and the image selected 

in step 1 is displayed.

Transferring Images to Other Image Editing Software
You can merge up to four JPEG images to create panorama images. 
For merging images, start up the image-merging software “PhotoStitch” 
from ZB and use.

1 Select multiple images to merge (p.11).

2 Click the buttons [Edit]  [Stitch Photos].

¿PhotoStitch starts up and the main window appears.

Merging Images to Create Panorama Images
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3 Check the arrangement of the images to be merged 
and click the [2. Merge] tab sheet.
O If the arrangement of the images to be merged is not correct, 

drag the images to rearrange them.

¿The window switches to the [2. Merge] tab sheet.

4 Click [Start] to merge.

¿The images are merged and displayed.

5 Click the [3. Save] tab sheet.
¿The display switches to the [3. Save] tab sheet.
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6 Check the save range and then click [Save].

¿The [Save As] dialog box appears.

7 Specify the save destination and then click the 
[Save] button.
¿The merged images are saved.

8Select the [File] menu  [Exit].
¿PhotoStitch exits.

Save range
Drag [ ] to change the range

See also the Help that are displayed when you click [ ] on the 
right of the window for information on operating PhotoStitch and 
PhotoStitch functions.

Adjusting RAW Images
You can make the same adjustments (reset processing conditions) to 
RAW images as the functions that are available on the camera, such as 
brightness and white balance adjustment. You can also convert edited 
RAW images to JPEG or TIFF images and save them.
Because only the image processing conditions are changed when a 
RAW image is adjusted, the original image data remains totally 
unaffected. For this reason, image deterioration that usually 
accompanies editing does not occur and you can readjust, redo or undo 
changes knowing that you can always revert to the original shot 
condition of the image.

1 Select a RAW image.

2 Click the buttons [Edit]  [Process RAW Images].

¿RAW Image Task starts up and the main window appears.
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3 Adjust the image.

¿The image is adjusted.
¿For the adjustment items in the RAW Image Task main window, 

refer to p.79.
O Adjustment items displayed in [Image Quality Adjustment] vary 

depending on the camera model used for shooting the RAW 
image.

4 Click the [Save] button.

¿The [Save] dialog box appears.

RAW Image Task main window 5 Specify the type for the image to be saved and the 
save destination, and then click the [Save] button.

¿The processing dialog box appears and the JPEG image or TIFF 
image that has been converted from a RAW image is saved in 
the specified place. The RAW image remains unaffected.

6 Select the [File] menu  [Exit] to exit.
¿RAW Image Task exits.

See also [RAW Image Task Help] and the [Help] menu for 
information on operating RAW Image Task and RAW Image Task 
functions.
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1 Remove the check mark from [Preview].
2 Set multiple adjustment items.
3 Click the [Update] button.

¿ All the adjustments are saved to the image and redisplayed in one 
operation.

You can apply the settings that have been adjusted in [Image Quality 
Adjustment] to another image by selecting the [Edit] menu  
[Development Conditions]  [Copy] or [Paste] in the RAW Image Task 
main window (p.79). You can also select [Save] or [Load] to save or 
download the settings as a separate file from the image (extension 
“.DVP”).

Applying multiple adjustment settings to an image at one 
time

Applying adjustment settings to another image

O It takes approximately 1 to 3 seconds until the adjusted image is 
redisplayed (undergone development processing) (when using 
the following: OS: Windows XP; CPU: 2.2 GHz Pentium 4; RAM: 
512MB). However, the time it takes to redisplay an image varies 
greatly depending on the camera model used to shoot the image, 
computer type and the subject of the image.

O A Picture Style file is an extended function of Picture Style. It is a 
file that offers effective image characteristics for an image shot in 
an extremely limited scene. For more details on Picture Style files, 
refer to the Canon’s web site.

You can apply Picture Style files downloaded from Canon’s web site and 
saved to your computer, as well as Picture Style files created with 
Picture Style Editor and saved to your computer, to RAW images. 

1 Display the main window of RAW Image Task (p.59).

2 Click [ ].

¿The [Open] window appears.

3 Select a Picture Style file, and then click the [Open] 
button.

¿The Picture Style file is loaded and applied to the image.

Applying Picture Style Files
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O A Picture Style file is an extended function of Picture Style. For 
more details on Picture Style files, refer to the Canon’s web site.

O The Picture Style files that you can apply to the camera are files 
with the “.PF2” extension only.

O Only one Picture Style file can be loaded for one RAW image. To 
apply another Picture Style file, repeat steps 2 to 3.

O For details on using Picture Style Editor, refer to the “Picture Style 
Editor Instruction Manual” (PDF electronic manual).

White balance (EOS-1D series cameras and EOS 40D) and tone curve 
(EOS-1D series cameras excluding EOS-1Ds Mark III and EOS-1D 
Mark III) adjustments made to RAW images can be saved as a file as 
explained below and then registered to a camera and used.
For information on registering cameras, see the two related pages 
below in “Chapter 2: Setting the Camera from Your Computer” in the 
“EOS Utility Instruction Manual” (PDF electronic manual).
O For details on white balance files, refer to “Registering Personal White 

Balance in the Camera”.
O For details on tone curve files, refer to “Setting Parameters and 

Applying to the Camera”.

Saving White Balance Files

1 Adjust white balance in [Image Quality Adjustment].

2 Click [ ] to save as a white balance file.
O Click [ ] to save the adjusted white balance results as a white 

balance file (extension “.WBD”).

3 Use EOS Utility to register the saved file to the 
camera.

White Balance Files and Tone Curve Files
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Saving Tone Curve Files (Excludes the EOS-
1Ds Mark III and EOS-1D Mark III)

1 Click [ ] in [Image Quality Adjustment] and adjust 
the tone curve.

2 Click the [Save] button to save as a tone curve file.
O Click the [Save] button in the [Tone Curve] dialog box to save the 

adjusted tone curve as a tone curve file (extension “.TCD”).

3 Use EOS Utility to register the saved file to the 
camera.

O White balance files are not compatible with other camera models.
O Tone curve files for the EOS-1Ds Mark II and the EOS-1D Mark II 

are compatible and tone curve files for the EOS-1Ds and the 
EOS-1D are compatible.

O White balance files and tone curve files are compatible with 
Windows and Macintosh computers.

Adding Sound to Images/Playing Back
You can add sound to images and play back sound which you have 
added to images with a camera that has a sound record function.

You can add WAVE sound files to images (extension “.WAV”).

You can play back sound files that are attached to images.

1 Select an image to which you want to add sound.

2 Select the [Edit] menu  [Add/Remove Sound].
¿The [Sound] dialog box appears.

3 Click the [Add] button and select the sound file to be 
added to the image.
O Select a WAVE sound file.
¿The display returns to the [Sound] dialog box.

4 Click the [OK] button to close the dialog box.
¿The [ ] icon is displayed on images to which sound has been 

added.

1 Select an image to which a [ ] icon is attached.

2 Select the [Edit] menu  [Play Sound].
¿The sound is played back.

Adding Sound to Images

Playing Back Sound
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Printing Using Other Printing Software
You can start up printing software installed on your computer from within 
ZB and print images.

1 Select an image you want to print.

2 Click the buttons [Print]  [Print Using Other 
Software].
¿The [Print Using Other Software] window appears.

3 Select the printing software and then click the 
[Launch] button.
¿The printing software starts up and the image you selected in 

step 1 is displayed.

4 Make the necessary settings in the printing software 
and print.

Printing software that is incompatible with ZB does not appear in the 
[Print Using Other Software] window and can therefore not be used to 
print.

Printing software does not appear
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Preferences
You can change any of the ZB functions in the preferences window. 
Check the settings displayed for each window before making changes.

1 Select the [Tools] menu  [Preferences].

2 Select the tab sheet to be set, make changes to the 
settings and then click the [OK] button.

You can make settings such as adjusting the minimum size of thumbnail 
images that are displayed in the main window, the speed of Zoom Mode 
(p.73), the levels of image and folder display in Scroll Mode (p.74) and 
color management. 

General Settings
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You can make settings related to image selection.

Selection Settings
You can make settings related to image rotation.

Rotation Settings
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If you are printing with the [Photo Print] window (p.15), you can set 
whether to trim the image and print with no borders around the paper, or 
to print as is without trimming. 

Printing Settings
You can set the information that is displayed when you click [ ] 
(shooting information display) in the viewer window (p.76).

Shooting Information Settings
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You can set the background color for the main window.

Themes Settings
Showing/Hiding Task Buttons
You can show or hide task buttons displayed on the left of the main 
window according to your requirements. Hiding buttons you do not use 
makes operating ZB easier.

1 Select the [Tools] menu  [Customize].
¿The [Customize] dialog box appears.

2 Remove the check mark from the buttons you want 
to hide.

3 Click the [OK] button to apply your changes.

4 Restart ZB for the settings to be applied.
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Troubleshooting
If ZB is not operating correctly, refer to the items below.
Also refer to the Help from the [Help] menu or click the [?] button at the 
top of each window and refer to the Help displayed.

O You cannot install the software if a user setting other than [Computer 
administrator] privilege or [Administrator] privilege is selected. Select 
the [Computer administrator] privilege user setting in Windows XP or 
the [Administrator] privilege user setting in Windows 2000. For 
detailed information on selecting the user setting, refer to your 
computer User’s Manual.

O ZB does not operate correctly on a computer if its system 
requirements does not meet. Use ZB on a computer with compatible 
system requirements (p.72).

O Even if your computer has the RAM capacity (memory) described in 
the system requirements (p.72), if other applications are running at 
the same time as ZB, you may not have sufficient RAM (memory). 
Exit any applications other than ZB.

O Images that are not supported by ZB (p.72) do not display. There are 
various types of JPEG and TIFF images, so JPEG images other than 
Exif 2.2 and 2.21 compatible images and TIFF images other than Exif 
compatible images may not display properly.

O With initial settings, the color of images that have been shot in Adobe 
RGB appear weak. In this case, check the [General] tab sheet in 
preferences and checkmark [Adjust color of images using monitor 
profile] (p.66). Color management is performed and the color of the 
image shot with an Adobe RGB setting and the image shot with an 
sRGB setting are matched.

Installation could not be completed correctly

ZB does not work

Images do not display properly

Deleting the Software (Uninstalling)
O Exit any applications before uninstalling the software.
O Log in under the Computer administrator/Administrator privileges 

when uninstalling the software.
O To prevent computer malfunctions, always restart your computer after 

you have uninstalled the software. Re-installing the software without 
first restarting your computer is particularly likely to result in computer 
malfunctions.

1 Select the [Start] button  [All Programs] 
([Programs] in Windows 2000)  [Canon Utilities]  
[ZoomBrowser EX]  [ZoomBrowser EX Uninstall].

2 Proceed with the uninstallation as directed by the 
on-screen messages.
¿The software is uninstalled. 
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*1 Compatible with 32-bit/64-bit systems for all versions except Starter 
Edition

*2 Compatible with Service Pack 2   
*3  Compatible with Service Pack 4
*4 .NET Flamework is Microsoft software. It is installed together with ZB.

OS
Windows Vista*1
Windows XP Professional/Home Edition*2
Windows 2000 Professional*3

Computer
PC with one of the above OS preinstalled (Upgraded 
machines not supported) 
* .NET Flamework 2.0 or later is required.*4

CPU
Windows Vista 1.3GHz Pentium or higher
Windows XP, 2000 500MHz Pentium or higher

RAM
Windows Vista Minimum 512MB
Windows XP, 2000 Minimum 256MB

Display Screen resolution: 1024 × 768 pixels or more
Color quality: Medium (16 bit) or more

Supported Images
Image type/Camera used Extension

JPEG images
JPEG images shot with a Canon digital 
camera (Exif 2.2 or 2.21-compatible 
JPEG images)

.JPG, .JPEG

RAW images

EOS-1Ds Mark III EOS-1D Mark III
EOS-1D Mark II N EOS-1Ds Mark II
EOS-1D Mark II EOS 5D
EOS 40D EOS 30D
EOS 20D/20Da
EOS DIGITAL REBEL XSi/450D
EOS DIGITAL REBEL XTi/400D DIGITAL
EOS DIGITAL REBEL XT/350D DIGITAL
EOS DIGITAL REBEL XS/1000D

.CR2

EOS-1Ds EOS-1D .TIF
EOS 10D
EOS DIGITAL REBEL/300D DIGITAL
EOS D60 EOS D30

.CRW

TIFF images Exif-compatible TIFF images .TIF, .TIFF
BMP images Bitmap images .BMP
PCD images Photo CD images .PCD

System Requirements
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Zoom Mode

Folder path

Display magnification (p.13)
Filter display (p.22)

Reduction display (p.13)
Enlargement display (p.13)
Cancels [ ], [ ] or [ ]
Shows/hides the image or 
folder information
Selects/deselects all the 
images or folders
Displays the folder one level 
above
Returns to the display of the 
folder before [ ] is clicked
Returns to the display of the 
folder previously displayed

Image display area

Bracketing iconProtect icon Audio recording icon

Number of selected images

RAW image iconShows/hides the task buttons and folder area

*1 The [CANON iMAGE GATEWAY] button may not be displayed depending on the area you are in.
*2 Images in folders and folders selected here are displayed on the image display area.

Task buttons*1

Folder area*2

Viewer window (p.76)

Properties window (p.47)
Slide show (p.36)

Image search (p.53) Deletes images (p.26)
Rotates an image

Moves the enlargement display position (p.13)

Full view (p.13)

Shows/hides 
the task buttons

List of Main Window Functions
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Scroll Mode

Folder path

Display magnification (p.13)

Filter display (p.22)
Shows/hides the image or 
folder information

Selects/deselects all the 
images or folders

Displays the folder one level 
above

Returns to the display of the 
folder before [ ] is clicked

Returns to the display of the 
folder previously displayed

Image display area

Number of selected imagesShows/hides the task buttons and folder area

*1 The [CANON iMAGE GATEWAY] button may not be displayed depending on the area you are in.
*2 Images in folders and folders selected here are displayed on the image display area.

Task buttons*1

Viewer window (p.76)

Properties window (p.47)
Slide show (p.36)

Image search (p.53) Deletes images (p.26)
Rotates an image

Folder area*2

Shows/hides 
the task buttons
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Preview Mode

Folder path

Filter display (p.22)

Shows/hides the image or 
folder information

Selects/deselects all the 
images or folders

Displays the folder one level 
above

Returns to the display of the 
folder before [ ] is clicked

Returns to the display of the 
folder previously displayed

Information display area

Number of selected images
Shows/hides the task buttons and folder area

*1 The [CANON iMAGE GATEWAY] button may not be displayed depending on the area you are in.
*2 Images in folders and folders selected here are displayed on the thumbnail image display area.
*3 Images selected here are displayed on the image display area.

Task buttons*1

Viewer window (p.76)

Slide show (p.36)
Image display area

Rotates an image

Shooting information (p.47)

Thumbnail image display 
area*3

Shows/hides the information display area
Switches between images

Deletes images (p.26)
Image search (p.53)

Folder area*2

Shows/hides 
the task buttons
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List of Viewer Window Functions

Synchronize (p.44)
File name

Rating (p.21)
Full view display (p.14)

Folder path

Switches between 
images
Fit-to-window view 
(p.21)

100% (actual pixel 
size) view
Display magnification 
(p.21)

Enlargement display (p.21)

Reduction display (p.21)

Moves the enlargement display position (p.21)
Photo print window (p.77) Edits (p.29 to p.35, p.54 to p.57)

Shows/hides the AF point

Shows/hides the shooting information (p.14, p.20)

Split displays (p.44)
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List of Photo Print Window Functions

Trims the image

Print preview

Number of prints

Switches the printing image

Shot date and 
time printing

Printer selection and 
settings

Inserts text

Borderless printing
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List of Index Print Window Functions

Layout settings

Print preview

Switches the printing page

Print information 
settings

Printer selection and settings

Number of prints

Paper orientation
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List of RAW Image Task Main Window Functions

Sets a check mark
Rotates the image

Fit-to-window view
100% (actual pixel size) view

Enlargement/reduction 
display

Image display area

Cursor coordinates 
position and RGB value 
(8-bit conversion)

Displays the image selected in 
the thumbnail image display area

Thumbnail image 
display area

Switches between 
displayed images

Transfers the image to image editing software
Saves the image

Cancels [ ], [ ] or [ ]

Zooms in
Zooms out

Moves the enlargement display position

Brightness adjustment

Click white balance 
Saves the set white 
balance as a white 
balance file

Loads a Picture Style file 
and applies it to the image

Applies and redisplays 
multiple adjustment 
settings in a single 
operation

Cancels all settings and 
reverts to the status at the 
time of shooting

Checkmark to redisplay 
for each adjustment made

Shows/hides the [Navigator]
Shows/hides the [Histogram]

Shows/hides the [Image Quality Adjustment]
O The settings at the time of shooting are displayed 

in bold and italics in the list boxes.

Shows/hides the thumbnail image display area Shows/hides the shooting 
information
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Contents Lookup
Downloading Images to Your Computer
O Download images by connecting your camera 

and computer ¿ p.7

O Download images using a card reader ¿ p.9

Image Checking
O Look through ¿ p.11
O Enlarge and view ¿ p.13, p.20
O Check efficiently ¿ p.23
O Compare multiple images ¿ p.44
O Check the shooting information such as shot 

date ¿ p.47

O View as a slide show ¿ p.36

Image Printing
O Print one image on one page ¿ p.15
O Print using Easy-PhotoPrint EX ¿ p.16
O Arrange multiple images on one page and print ¿ p.42

Organizing Images
O Sort by rating ¿ p.21
O Move to a different location ¿ p.25
O Move by entire folder to a different location ¿ p.25
O Change the file name ¿ p.26
O Delete ¿ p.26
O Classify by shot date ¿ p.52
O Search ¿ p.53

Image Editing
O Use automatic adjustment ¿ p.29
O Adjust brightness/darkness ¿ p.31
O Make colors more vivid ¿ p.31
O Raise the contrast ¿ p.31
O Trim parts of an image ¿ p.32
O Specify an aspect ratio that matches the size of 

the paper on which an image is to be printed ¿ p.32

O Make an image sharp ¿ p.34
O Insert text ¿ p.33
O Correct red-eye ¿ p.35
O Merge ¿ p.57
O Adjust RAW images ¿ p.59

Utilizing Images
O Attach an image to an e-mail ¿ p.37
O Make into computer wallpaper ¿ p.38
O Make into a computer screen saver ¿ p.39

Converting Images
O Change the size ¿ p.48
O Convert to a different type ¿ p.48
O Convert a RAW image to a JPEG or TIFF image ¿ p.59
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A
Adding Sound to Images.....................................................................  63
Adjust JPEG Images.....................................................................  29, 54
Adjust RAW Images............................................................................  59
Adjusting (JPEG or TIFF Image)...................................................  29, 54

Adjusting in RGB ..........................................................................  54
Adjusting the Brightness...............................................................  31
Adjusting the Brightness Level .....................................................  55
Adjusting the Contrast ..................................................................  31
Adjusting the Saturation ...............................................................  31
Adjusting the Sharpness ..............................................................  34
Adjusting the Tone Curve.............................................................  55
Automatic Adjustment ..................................................................  29
Correcting Red-eye ......................................................................  35
Unsharpening Mask .....................................................................  56

Adjusting (RAW image).......................................................................  59
Adjusting Color Saturation............................................................  79
Adjusting Color Tone....................................................................  79
Adjusting the Contrast ..................................................................  79
Adjusting the Sharpness ..............................................................  79
Adjusting White Balance ..............................................................  79
Click White Balance .....................................................................  79
Picture Style .................................................................................  79
Picture Style File ..........................................................................  61

Adjusting Images in RGB....................................................................  54
Adjusting the Brightness .....................................................................  31
Adjusting the Brightness Level............................................................  55
Adjusting the Contrast.........................................................................  31
Adjusting the Saturation......................................................................  31
Adjusting the Sharpness .....................................................................  34
Adjusting the Tone Curve ...................................................................  55
Attach an Image to an E-mail..............................................................  37
Automatic Adjustment .........................................................................  29

B
Batch Change the File Name of Images .............................................  51

C
Change File Name..............................................................................  26

Change Folder Name .......................................................................... 26
Change the Display Magnification ....................................................... 13
Changing the Folder Level Settings .................................................... 46
Changing the Size and Type of an Image and Saving ........................ 48
Checking the Shooting Information ..................................................... 47
Classifying the Images by Shot Date................................................... 52
Click White Balance............................................................................. 79
Color Management .............................................................................. 66
Compare Multiple Images.................................................................... 44
Contrast ............................................................................................... 31
Correcting Red-eye ............................................................................. 35
Creating a Folder................................................................................. 24

D
Delete

Delete Folders............................................................................... 27
Delete Images............................................................................... 26
Delete the Software ...................................................................... 71

Delete Folders ..................................................................................... 27
Delete Images ..................................................................................... 26
Delete the Software (Uninstalling) ....................................................... 71
Deleting the ZB (Uninstalling).............................................................. 71
Displaying Images Shot with Adobe RGB ........................................... 71
Downloading an Image to Your Computer ............................................ 7

Downloading Images from a Camera ............................................. 7
Downloading Images from a Card Reader...................................... 9

Downloading Images ............................................................................. 7
Downloading Images from a Card Reader ............................................ 9

E
Editing.................................................................................................. 81
Enlarge Folders ................................................................................... 12
Enlarge Images ............................................................................. 13, 21
Exiting ZB ............................................................................................ 18
Exporting Shooting Information ........................................................... 49

F
Favorite Folders................................................................................... 27

Adjusting
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Full View Display.................................................................................  14

G
General Settings (Preferences) ..........................................................  66

I
Index Printing ......................................................................................  42
Insert Text ...........................................................................................  33
Inserting Comments............................................................................  50
Inserting Text into Images...................................................................  33

K
Keywords Settings ..............................................................................  50

L
Listing Images by Folder Level ...........................................................  45

M
Main Window ..................................................................................  7, 73
Main Window (RAW Image Task).................................................  60, 79
Merging Panorama Images.................................................................  57
Move or Copy Folders.........................................................................  25
Move or Copy Images.........................................................................  25

N
Navigator window..........................................................................  13, 21

O
Operating with EOS Utility ....................................................................  8

P
Picture Style File .................................................................................  61
Playing Back Sound............................................................................  63
Preferences.........................................................................................  66

General Settings...........................................................................  66
Printing Settings ...........................................................................  68
Rotation Settings ..........................................................................  67
Selection Settings.........................................................................  67
Shooting Information Settings ......................................................  68
Themes Settings ..........................................................................  69

Preview Mode (Main Window) ......................................................  23, 75

Printing
Index Printing ................................................................................ 42
Printing an Image Using Easy-PhotoPrint EX............................... 16
Printing One Image on One Sheet of Paper ................................. 15
Printing with Printing Software other than EPP EX....................... 64

Printing an Image Using Easy-PhotoPrint EX ..................................... 16
Printing One Image on One Sheet of Paper........................................ 15
Printing Settings (Preferences)............................................................ 68

R
Ratings ................................................................................................ 21
RAW Image Task .......................................................................... 60, 79
Rotate images ......................................................................... 73, 74, 75
Rotation Settings (Preferences) .......................................................... 67

S
Save the White Balance File ............................................................... 62
Saving the Tone Curve File ................................................................. 63
Scroll Mode (Main Window)........................................................... 45, 74
Searching for Images .......................................................................... 53
Selection Settings (Preferences) ......................................................... 67
Setting a Screen Saver........................................................................ 39
Setting a Wallpaper ............................................................................. 38
Setting an Image as a Screen Saver................................................... 39
Setting an Image as Wallpaper ........................................................... 38
Shooting Information Settings (Preferences)....................................... 68
Simple Display..................................................................................... 11
Slide Show........................................................................................... 36
Starting up ZB........................................................................................ 7
Supported Images ............................................................................... 72
Synchronize Display ............................................................................ 44
System Requirements ......................................................................... 72

T
Themes Settings (Preferences)........................................................... 69
Thumbnail Display (Main Window) ...................................................... 11
Transfer Images to other Image Editing Software ............................... 57
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Trimming.............................................................................................  32
Trimming an Image.............................................................................  32

U
Unsharpening Mask ............................................................................  56

V
Viewer Window .......................................................................  14, 20, 76

W
White Balance.....................................................................................  79

Click White Balance .....................................................................  79
Writing Images to a CD.......................................................................  41
Writing to a CD....................................................................................  41

Z
Zoom Mode (Main Window)..........................................................  11, 73

About This Instruction Manual
O It is prohibited to reproduce, in whole or part, the contents of this 

Instruction Manual without permission.
O Canon may change without notice the software specifications and 

contents of this Instruction Manual.
O The software screens and displays printed in this Instruction Manual 

may differ slightly from the actual software.
O The content of this Instruction Manual has been reviewed thoroughly. 

However, if you should notice any errors or omissions, please contact 
a Canon Service Center.

O Please note that irrespective of the above-mentioned, Canon does 
not take responsibility for the outcome of the operation of the 
software.

Trademark Acknowledgments
O Microsoft and Windows are registered trademarks or trademarks of 

Microsoft Corporation in the United States and/or other countries.
O Other names and products not mentioned above may be registered 

trademarks or trademarks of their respective companies.
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